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USB port

PC sideRecorder side

1.1 Foreword 

This instruction manual describes installation and operation for the parameter loader of the paperless 

recorder. Read it carefully before use. 

 

1.2 Parameter loader for paperless recorder 

Connect the parameter loader (hereafter referred to as loader) to the paperless recorder using 

commercially available USB cable or LAN cable, and referencing (uploading), editing, and setting 

(downloading) of each parameter of the paperless recorder can be made. Connect USB miniB type 

male connector to the paperless recorder. 

Note: Optionally available dedicated cable is required to use the loader for program versions V01A to 

V22A of the paperless recorder PHR main unit. 

 

1.3 Contents of package 

The following items are packaged with the product. 

• CD-ROM for installation: 1 

• Instruction manual which is installed to above CD-ROM 

 

1.4 Recommended operating environment 

• Microsoft Windows 2000 or XP or Windows 7 (Home Premium, Professional (Not applicable 

for 64 bit version)). (Operation by Windows 95/98/Me/NT is not secured.) 

• Hard disk with a free capacity of 30MB or more 

• RAM with 64MB or more 

• USB port 

• USB cable [USB(A) male–USB(miniB) male, or Type PHZP1801] 

• LAN port (when provided with Ethernet option) 

• LAN cable (when provided with Ethernet option) 

Note: Hardware requirements of the loader are as follows when it is used for program versions 

V01A to V22A of the paperless recorder PHR. 

• RS-232C serial port (D-sub 9 pin) 

• Communication cable dedicated to parameter loader (Option: PHZP0201) 

 

1. OUTLINE
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1.5 Installing the parameter loader for paperless recorder 
1) If other application software programs are open, terminate all of them. 
2) If the programming loader has been already installed, open “Add/Remove Programs” on 

Control Panel and delete the parameter loader. 
3) Set CD-ROM in the personal computer drive. 
4) Start “Setup. exe” in the CD-ROM. 
5) Follow the prompts displayed on the screen. 
6) Please install the main body of the parameter loader.  

A message is displayed, prompting you to verify that “Parameter loader setup is complete”. 
Now, the Parameter Loader installation is completed. 

 

 

1.6 Installing USB communication driver 
The driver can be installed on Windows XP as follows for example. 

1) Connect the USB port of the paperless recorder whose power has been turned on and a 
running PC with a USB cable. 

2) The message “Found New Hardware” and then the driver installation wizard appear on the 
computer.  Click the [Next] button. 

  



 

INP-TN513551-E 3 

3) When the dialog box below is displayed, select [Display a list of the known drivers for this 
device so that I can choose a specific driver] and click the [Next] button. 

 

4) The dialog box below is displayed.  Select [Other Devices] and click the [Next] button. 

 

5) The dialog box below is displayed.  Click [Have Disk]. 
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6) The [Install From Disk] dialog box is displayed.  Click the [Browse] button. 

 

7) The USB driver “OP-U.inf” is automatically stored in the “inf” folder within the install folder 
(“C: ¥ Program Files ¥ ParameterLoader” usually) of the parameter loader.   
Select the “OP-U.inf” file and then click “Open.” 

 

8) The previous dialog box is displayed again.  Check the path shown under [Copy 
Manufacturer’s Files From:] and click the [OK] button. 

 

9) The dialog box below is displayed.  Check that [Operation Panel USB Driver] is shown 
under [Models:].  Click the [Next] button. 
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10) The driver installation starts. 

 

11) The dialog box below is displayed on completion of installation.  Click the [Finish] button. 
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Recognition of USB Driver 
When the driver has been installed successfully and the paperless recorder and the computer are 
connected with a USB cable, the [Device Manager] window shows “Operation Panel - Operation 
Panel USB Driver.” 

 

This will disappear when the paperless recorder and the computer are disconnected. 
If [Other Device] or [?] is shown even while their connection via USB is maintained, the USB driver 
may not be recognized. If this happens, uninstall the USB driver once and reinstall it. 
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1.7 Uninstalling the parameter loader software for paperless 
recorder 
For un-installation of the parameter loader for the paperless recorder, proceed from Start of Windows 
→ Setting → Control Panel → Add or delete application. And select Recorder Parameter Loader and 
follow Windows’ instructions and cautions to delete it. 
When you install a different version, be sure to un-install the software, which is currently installed, in 
advance in the above procedures. If not un-installed, it might result in malfunctions such as not 
starting. 

 

1.8 Cautions 
When operating the Loader, be careful of the following items: 

1) The Loader is used for the paperless recorder only. 
2) Initial values on each Loader screen may be different from those of the paperless recorder 

main unit. 
3) For the communication setting for the paperless recorder (“Main Unit Set” → 

“Communication Setting”), the Front communication function should be set to ON. (After the 
Front communication function has been switched from OFF to ON, turn OFF the power once, 
and then turn it ON.) 

4) Before starting the paperless recorder, be sure to assure that the Loader setting is reflected to 
the paperless recorder. 

5) The Loader cannot use more than 1 window at the same time. 
If more than 1 window is open, leave only a single window open and close all of other 
windows (this can be checked on the Window menu). 

6) Whenever you want to write the setting data on parameter loader into paperless recorder, 
please return the display of paperless recorder to Display Mode such as Real Time Trend 
Screen. Don’t display Parameter Setting Screen, or this loader software may miss to write into 
the paperless recorder. 

7) When you use this loader to write into the paperless recorder PHR which the program version 
is V01A to V05A, and you change the input type to 0 to 5Vdc, paperless recorder receives the 
input type as 1 to 5Vdc instead of 0 to 5Vdc. And then, this loader’s setting is also changed to 
1 to 5Vdc. (This is because the main unit does not support 1 to 5Vdc input function.) 

8) At this loader, some parameters which do not exist on paperless recorder may be displayed. 
But the parameter which doesn’t exist in paperless recorder isn’t written. 

9) During the paperless recorder is recording or totalizing, it is impossible to write into the 
equipment from this parameter loader. 
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2.1 Start 

Click “Programs” ⇒ “Recorder Parameter Loader” ⇒ “Recorder Parameter Loader” from the Start 
menu. 

 

It is displayed such as following screen. 
Note) The screen for maximum channels is displayed, regardless of the number of channels of the 

paperless recorder. 

 

Table of setting channel display 

2. BASIC OPERATION 
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2.2 Table of setting channel display 

 

 

 

 

 

 
(1) Selection of setting model 

Setting model can be selected by the parameter loader. 

 

Display contents or setting range on the setting screen varies with each model. 
 PHR PHW 

Channel setting 18 channels (ch1 to 18) 36 channels (ch1 to 36) 
Calculation channel setting 12 channels (ch19 to 30) 36 channels (ch37 to 72) 
DI setting 10 16 
DO setting 28 36 
Screen group setting 4 groups 8 groups 

(7) File menu 
(8) Copy the setting value 

(2) Communication setting 

(3) Upload setting value from 
the paperless recorder 

(4) Download setting value to 
the paperless recorder 

(5) Setting of the 
paperless recorder is 
stored non-volatile 
memory 

(6) Time setting to 
the paperless 
recorder 

(1) Selection of setting 
model 
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(2) Communication setting 

The setting on the communication with the paperless recorder can be made. 
a) Communication 

The communication method with the paperless recorder can be selected from USB, Ethernet, 
and RS-232C. 
Note: 
1) USB or Ethernet communications cannot be conducted if the program version of the 

paperless recorder PHR is V01A to V22A. Make sure to set the station No. of the parameter 
loader to 1. 

2) RS-232C communications cannot be conducted if the program version of the paperless 
recorder PHW or PHR is V27A or later. Note that to conduct Ethernet communications, 
optional Ethernet communication board is necessary. To conduct USB communications, 
make sure to set the station No. of the parameter loader to 1. 

 

b) IP Address, Station No. 
Setting is necessary to conduct Ethernet communications with the paperless recorder. 
IP Address and Station No. of the paperless recorder can be set. 
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c) Port 
Setting is necessary to conduct RS-232C communications with the paperless recorder. 
The communication port of the PC used to communicate with the paperless recorder can be set. 
This function can change communication port of PC which communicates with paperless 
recorder. At starting of this loader, COM1 is selected as communication port. Set the port 
number that you want to use at first.  
At the executing screen, click [Com(R)] → [Port(P)] and select using port. Normally, COM1 is 
selected. (Normally COM1 is selected.) 

 

(3) Upload setting value from the paperless recorder 
It is available to upload all the setting such as channel setting, math channel setting, main 
setting, display setting and so on from the paperless recorder. 

(4) Download setting value to the paperless recorder 
It is available to download all the setting such as channel setting, math channel setting, main 
setting, display setting and so on to the paperless recorder. 
Note: 1) Download prohibit during recording or totalizing. 
 2) After the data has been downloaded to the paperless recorder, store non-volatile 

memory, or the setting value will return to the former value when power is turned 
OFF. 

(5) The data downloaded to the paperless recorder can be stored non-volatile memory. 
(6) Time setting to the paperless recorder 

It is available to change time setting of the paperless recorder. Press [Time setting] button, and 
screen as shown below appears. Set the time that you want to change. And then press [Change] 
button. 
Note: 1) This setting prohibit during recording or totalizing. 
 2) This setting is not necessary to be stored non-volatile memory. 

 

Screen of time setting 
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(7) File menu 
This menu, you can use functions as shown below. 

 

a) [Open(O)] 
Paperless recorder parameter setting files stored in your PC can be opened. 
Parameter setting files stored in the paperless recorder can also be opened. 

b) [Save in file(S)] 
Parameters currently being set can be stored in your PC. For parameter setting file to be 
created, extensions vary depending on setting model. 
In case of PHR: ******PHR 
In case of PHW: ******PHW 
Parameter setting file to be created: *****.PHR 
Substitute ***** with an arbitrary name. Select a file name consisting of alphanumeric 
characters with 7 uppercase characters or less when a parameter setting file is to be read from 
a compact flash card to the paperless recorder. 
Example: 
OK: PARA00.PHR, P123456.PHR NG: Para00.PHR, P1234567.PHR 
 
Note) To write the setting file in the compact flash card, which was created by the parameter 
loader, to a older version of the paperless recorder (V39A or older), be sure to perform the 
following settings: 

(1) Set “0” for the password for starting/stopping the recording.  If a value other than 
“0” is set, a password setting screen appears when the recording starts/stops. 

(2) Select “Display only” for all the recording operation settings of the Math channel.  If 
an item other than “Display only” is selected, a measured value of the Math channel is 
recorded when recording. 

However, if you write a setting value via communication, the above problems do not occur. 
If a password setting screen appears when the recording starts/stops or a measured value of the 
Math channel is recorded due to the reasons mentioned above, initialize the setting values and 
perform the settings again. 
 



 
 

INP-TN513551-E 13 

c)  [Text output(T)] 
Output setting value as text data. 
Please refer to attached “Appendix. 1: Example of setting parameters to be printed out.” 

d) [Exit(X)] 
Exit this menu. 

Note: 1) If you change setting value of the paperless recorder, register the setting value before 
exit this software. 

 2) If you want to use setting value on another day, it is recommended to save the setting 
value file of the paperless recorder before exit this software. 

(8) Copy the setting value 
Copy the setting value such as channel setting, main setting, display setting and so on. 
Click in line of original data and press [Copy]. Click in line that you want to copy, and then 
press [Paste]. 
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2.3 Setting channels 
Set the parameter regarding to input, calculation, alarm, display and record of each channel. 
On “Table of setting channel display”, double-click the channel you want to change. 

 

And then channel setting display appears. 
* Settable number of channels depends on setting model.  

In case of PHR, it is available to set till 18ch regardless of number of channels. 
In case of PHW, it is available to set till 36ch regardless of number of channels. 

* There are some screens to be able to display up to 7 characters as channel tag in spite of setting is 
available up to 8 characters. So don’t set 8 characters as channel tag. 

* When you set out of the range, message as shown below appears. 

 

Message in recording range 
 

* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off 
and on the paperless recorder, setting value returns before you change. 
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* The input type becomes same kind in every two channels set. 
(1) When input type of each channel is changed, setting is subjected to limitations. 

In case of PHR: The type setting of channel 2, 4, 6, 8, 11, 13, 15 and 17 is available only with 
the same input category of previous channel. Note that, channel 9 and 18 can 
select the input type regardless of other channels. 

In case of PHW: The type setting of channel 2, 4, 6, 8, 11, 13, 15, 17, 20, 22, 24, 26, 29, 31, 33 
and 35 is available only with the same input category of previous channel. 
Note that, channel 9, 18, 27 and 36 can select the input type regardless of 
other channels. 

 
Input type is shown as follows. 

Input category Input type 
Thermocouple, 50mV K-Type TC, E-Type TC, J-Type TC, T-Type TC, R-Type TC, S-Type 

TC, B-Type TC, N-Type TC, W-Type TC, L-Type TC, U-Type TC, 
PN-Type TC, 50mV 

Resistance bulb Pt100Ω, JPt100Ω 
500mV 500mV 
5V 1 to 5Vdc, 0 to 5Vdc 

 
For example, when channel 1 is set to 1 to 5V, channel 2 is available to set only 1-5V, 0-5V, or 
Skip as shown below. 
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Example: Setting input type of each channel 
 Input type Input type Explanation 
Channel 1 K-Type TC 
Channel 2 T-Type TC 

Thermocouple, 50mV It is available to set any type of TC to each 
channel. 

Channel 3 1 to 5V 
Channel 4 0 to 5V 

5V  

Channel 5 Pt100 
Channel 6 JPt100 

Resistance bulb It is available to set any type of resistance 
bulb to each channel. 

Channel 7 500mV 
Channel 8 500mV 

500mV  

Channel 9 J-Type TC Thermocouple, 50mV It is available to set any input type to 
channel 9. 

Channel 10 K-Type TC 
Channel 11 50mV 

Thermocouple, 50mV The same input type is basically allocated 
to 2 channels. 

Channel 12 Skip 
Channel 13 1 to 5V 

5V 

Channel 14 Pt100 
Channel 15 Skip 

Resistance bulb 

Channel 16 Skip 
Channel 17 500mV 

500mV 

It is available to set skip under any input 
type. 

Channel 18 50mV Thermocouple, 50mV It is available to set any input type to 
channel 18. 

 
(2) When the input type of the channel is changed, the initialization of the input type of next 

channel might be required. 
In case of PHR: 
When the input type for channels 1, 3, 5, 7, 10, 12, 14 and 16 is changed, the initialization of the 
next channel might be required. 
In case of PHW: 
When the input type for channels 1, 3, 5, 7, 10, 12, 14, 16, 19, 21, 23, 25, 27, 30, 32 and 34 is 
changed, the initialization of the next channel might be required. When the initialization of the 
next channel is required, when the “Application” button is pressed, the following message 
screen appears. 

 

At this screen, if you press [OK] button, the input type of next channel is initialized to the same 
input type of current displayed channel. In case of 50mV, the next channel becomes K-type TC. 
In case of resistance bulb, the next becomes Pt100Ω. 
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* When you set input unit, set ON the “Scaling” at first. And then press “SELECT” key.  
In case of Thermocouple or Resistance bulb input, it is available to select either Celsius or 
Fahrenheit. And the others unit are not displayed. 

 

 
The Unit Select screen appears. On the screen that is displayed, click a unit and press the 
[Apply] button. Note that the unit cannot be selected without pressing the [Apply] button. 

 

Example: At voltage input and scaling ON 
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2.3.1 Copying the channel set 
This screen allows you to copy one or more set values from one channel to another. 
Move the cursor to CH on the Table of Setting Channel display, and click it (channel selection). 
Click [Edit] → [Copy]. 

 
 

 

Move the cursor to CH where you want to paste channel settings and click it (Channel selection). 
Click [Edit] → [Paste]. 

 
 

 

Click “Copy”. Select channel. 

Select “Paste”. Select “CH”. 
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Next, the following message appears, prompting you to select the option. 
Click [OK] when you want to copy the channel setting. 
If the input type is different between current type and new one, the paperless recorder works such as 
below. 

 
(1) Copying of Channel Setting in PHR 

1) When the copy destination is cannels 1 to 8, and 10 to 17: 
The same input types (*2) are used for their paired channels (*1). 
(*1: The paired channels are 1ch and 2ch, 3ch and 4ch, 5ch and 6ch, 7ch and 8ch, 10ch and 
11ch, 12ch and 13ch, 14ch and 15ch, and 16ch and 17ch.) 
(*2: The K thermocouple input is used for the thermocouple, and the Pt100Ω input for the 
resistance thermometer.) 

2) When the copy destination is 9ch and 18ch: 
No channel changes other than 9ch and 18ch. 

 
(2) Copy of Channel Setting in PHW 

1) When the copy destination is channels 1 to 8, 10 to 17,19 to 26, and 28 to 35: 
The same input types (*2) are used for their paired channels (*1). 
(*1: The paired channels are 1ch and 2ch, 3ch and 4ch. 5ch and 6ch, 7ch and 8ch, 10ch and 
11ch, 12ch and 13ch, 14ch and 15ch, 16ch and 17ch, 19ch and 20ch, 21ch and 22ch, 23ch and 
24ch, 25ch and 26ch, 28ch and 29ch, 30ch and 31ch, 32ch and 33ch, and 34ch and 35ch.) 
(*2: The K thermocouple input is used for the thermocouple, and the Pt100Ω input for the 
resistance thermometer.) 

2) When the copy destination is 9ch, 18ch, 27ch and 36ch: 
No channel changes other than 9ch, 18ch, 27ch and 36ch. 
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2.4 Setting math channels 
Set the parameter regarding to formula, input, totalize, alarm, display and record of each math channel. 
On “Table of setting math channel display”, double click the channel you want to change. 

 

And then math channel setting display appears. 
* Number of math channels differs according to model setting. 
 When PHR is selected : It is available to set till 12 channels between ch19 and ch30. 
 When PHW is selected : It is available to set till 36 channels between ch37 and ch72. 
* There are some screen to be able to display up to 7 characters as channel tag in spite of setting is 

available up to 8 characters.  So don’t set 8 characters as channel tag. 
* When you set out of the range, message as shown below appears. 

 

Message in recording range 
* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off 

and on the recorder, setting value returns before you change. 
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2.4.1 Setting of arithmetic expression 
Click the “Setting” button in the computing channel setting screen. 

 

The arithmetic expression setting screen appears. 
Select an arithmetic function and an input value and click “OK”. 

 
〈 List of functions usable for arithmetic expression 〉 

Display Function Description 
No display No arithmetic operation No arithmetic operation is performed. The input value is 

used as it is. 
ABS(A) Absolute value The absolute value of the value in the input A is found. 
POW(A,B) Exponentiation The “input B” power of the value in the input A is 

calculated. 
SQR(A) Square root The square root of the value in the input A is calculated. 
LOG(A) Log The common logarithm in the input A is calculated. 
LN(A) LN The natural logarithm in the input A is calculated. 
EXP(A) EXP “e exponentiation” of the value in the input A is 

calculated. 
RH(A,B) Humidity The relative humidity is calculated when the input A is 

dry-bulb temperature and the input B is wet-bulb 
temperature. 

MAX(A,B) Maximum value  
(between channels) 

The inputs A and B are compared to find the bigger 
value. 

MIN(A,B) Minimum value  
(between channels) 

The inputs A and B are compared to find the smaller 
value. 

H-P(A) Maximum value (time) The maximum value in the input A during a specified 
time is found. 

L-P(A) Minimum value (time) The minimum value in the input A during a specified 
time is found. 

AVG(A) Average value The average value in the input A during a specified time 
is calculated 

SUM(A,B) Cumulative value The cumulative value in the input (A/B) during a 
specified time is calculated. Cumulating calculation is 
performed every minute. 

 
〈 List of inputs usable for arithmetic expression 〉 

Display Content Display example 
Channel Channel input C01 
Cumulating calculation Channel cumulative value T01 
DI DI input D01 
Communication Communication input M01 
Constant Constant K01 
Temporary data Result of the last expression B01 
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2.4.2 Copying of math channel 
A setting value is copied to other computing channel. 
Put the cursor on the channel to be copied in the math channel setting list screen, and click it (channel 
selection).  
Click the “Edit” menu and select “Copy”. 

 
 

 

Put the cursor on the copy destination and click it (channel selection).  
Click the “Edit” menu and select “Paste”. 

 
 

 

Then the confirmation message appears.  
When the “OK” button is pressed, copying is performed. 

 

 

Click “Copy”. Select channel. 

Select “Paste”. Select “CH”. 
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2.5 Setting the main unit 
This screen allows you to set the recorder main unit. 
Move the cursor to “Main setting” on the Table of Setting Channel display, and click it. 

 

The Main unit Set screen appears. 
* Settable items vary depending on setting model.  

(The above screen is displayed when the setting model is PHR.) 
* If values are entered over the specified range, the following message appears. 

 

Alarm Hysteresis message 
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2.5.1 DI function (external control unit) setting (option) 
The DI function determines whether ON/OFF input from external devices connected to external 
terminal is accepted or not.  
DI point varies depending on setting model.  

PHR: DI1 to DI10 (Max. 10 points) 
PHW: DI1 to DI16 (Max. 16 points) 

 

Note: Without the DI option, DI function cannot be used. 
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2.6 Display setting 
At this screen, you can see or set regarding to screen setting such as structure of screen, trend display 
screen and so on. Click “Display setting” tab of Structure of setting channel display. 

 

 

Setting screen appears and you can see status about screen setting. 
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2.6.1 Display setting 

At this screen, you can set regarding to screen setting such as structure of screen, trend display screen 
and so on. Double click the group No. at “Display group” column on Display setting screen. 
* Edit the displayed group on “Selected group No.”. 
* Screen name (up to 16 characters) can be set to the recorder. 
* If scale display is ON, trend screen is divided in accordance with the scale, not the setting of 

“Display divided”. 

 
2.6.2 Setting channels 

Set the structure of screen. 
No.1 at this screen equals to data 1 of “display setting” of the paperless recorder, No.2 equals to data 2. 
Following is the same as above until No.10. 
* In case of the paperless recorder is 9 inputs type, this screen displays until No.10. 
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2.6.3 Setting message 
The screen allows you to set messages to be displayed when an event occurs. 
Move the cursor to No. of the Message box on the Main Unit Set screen and double-click it. 

 

The Message Setting screen appears. 

 
* Up to 32 characters is available for the message. The characters exceeding 32 cannnot be displayed 

on the recorder main unit. 

 
* After the input of message set data, be sure to press the “Apply” button, or the message cannot be 

registered. 

 
* Message timing is allocated as follows: 

 

 
 
 
 
 
Channel No. 
Set alarm No. 

 

 
 
 
 
 
DI No. 
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2.6.4 Unit coding 

Units can be made in alphanumerical characters. This unit can be registered in the input unit when 
scaling is set to ON on the Channel Setting screen. 
Move the cursor to No. of the Unit box on the Main Unit Set screen and double-click it. 

 

The Unit Setting screen appears. 

 
* A message (unit) consisting of up to 7 characters is available for the recording main unit. 

 
* After the input of unit set data, be sure to press the “Apply” button, or the unit cannot be 

registered. 
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2.7 Ethernet communication setting 
Settings related to Ethernet communications such as IP address, user name, operation setting of each 
Ethernet communication function of the paperless recorder can be checked or made. 
* Ethernet communication function cannot be used unless the paperless recorder main unit is 

provided with Ethernet communication option. 

 

* Up to 16 characters can be entered as user name. 
* Up to 8 characters can be entered as password. 

 



 

 30 INP-TN513551-E 

2.8 E-mail communication setting 
Settings related to E-mail communications such as send/receive address and send trigger can be made. 
* E-mail communication function cannot be used unless the paperless recorder main unit is provided 

with Ethernet communication option. 

 

* Up to 64 characters can be entered as send/receive address. 
* Up to 32 characters can be entered as sender name. 
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2.8.1 E-mail trigger setting 
Other conditions for E-mail transmission can be selected as follows. 
Move the cursor to “E-mail trigger” on the E-mail setting screen and double-click it. 

 

* Up to 32 characters can be entered as the title of E-mail and comments 1 and 2. 
* Be sure to press the [Apply] button to confirm the E-mail trigger setting data that has been entered. 
* E-mail trigger timing is allocated as shown below. 

 
• When sending E-mail by DI operation 

 

• When sending E-mail by alarm operation 

 

DI No. Channel No. 

Alarm No. 
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• When sending E-mail by alarm operation of 
the main unit 

 

• When sending E-mail at fixed intervals 
 

 

 

 

 

Alarm contents Transmission internal 

Reference time 
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APPENDIX.1 EXAMPLE OF SETTING PARAMETERS 
TO BE PRINTED OUT 
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INP-TN513551-E 35 
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